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Preface
Congratulations for purchasing the artem ComPASS 20 / 250 and 
welcome to the world of hotspots! In combination with an artem 
ComPoint, your new ComPASS 20 / 250 will become a complete 
hotspot solution enabling your customers, guests, or visitors to 
comfortably, quickly, and conveniently read e-mails, perform 
online banking, or simply surf in the Internet – in the mobile and 
wireless mode. It will not only be you who is one step ahead of his 
competitors, it will be your guests, as well.

With the artem ComPASS 20 / 250, you will hold the whole world 
of hotspots in your hands. Pass it on to your customers, guests, or 
visitors and give them service of freedom and mobility.

Yours, artem GmbH

Introduction

Flexibility and mobility have become crucial factors in today's busi-
ness environment, stipulating the need to provide highly efficient 
and ubiquitous access to data. A wireless infrastructure, as provided 
by artem with the ComPoint product family, serves to offer new 
opportunities to the most diverse target groups.

New Flexibility

Your decision to build a wireless infrastructure with the artem 
ComPoint will result in many benefits beyond the mere use of a 
wireless network. Now, you are much more flexible. Within the 
wireless infrastructure provided by artem, end devices are able to 
access the network at any given site, the network can grow with the 
demands made and according to the requirements of the users, 
and even bridging to other networks is possible. Without compli-
cated installation and the hassle of wiring. At any location you 
choose. Right where and when you need it.
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New Mobility

Modern work processes and new forms of collaboration rely more 
and more on the mobility and self-sufficiency of the workforce, 
but also on instant and ubiquitous access to critical data. Wireless 
communication with your ComPoint offers you the option in 
demand:
Speaking with your colleague Onair. In the meeting Onair. In the 
warehouse Onair. On the production site Onair. In the seminar 
room Onair. In the hotel room Onair. 
At the airport Onair. On your garden bench Onair. 
—Congratulations, the future of efficient workflows has just 
begun for you!

Objectives

Simply send your data along the most efficient route—directly 
over the air. The artem ComPoint product family provides the 
ideal set of options for all of your demands. The modular concept 
and versatility of the ComPoint family offer you the freedom and 
investment protection you'd expect from a cutting-edge wireless 
infrastructure solution. 
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Whether you plan to implement a large-scale wireless network 
spanning multiple sites, enhance the operational efficiency of your 
small- or medium-sized office with wireless connectivity, or wire-
lessly network your home: 

With the ComPoint family, artem offers solutions appropriate for 
each and every wireless user.

Knowledge Prerequisites
It is assumed that the reader possesses or is in the process of 
acquiring the following knowledge:

• Basic knowledge of the setup of networks,

• Knowledge of the basic networking terms and concepts, such 
as server, client, and IP address,

• Basic understanding of Microsoft Windows operating systems.

Manual Conventions
This manual uses the following text styles for the purpose of guid-
ing through the instructions:

• References to other manuals, chapters, or sections are repre-
sented in blue (in the online help screen and the PDF version 
of the manual) and are underlined.

Example:
See Manual Conventions.

• Menus, folders, functions, hardware labels, switch settings, 
system messages, etc. are represented in italic.

Example:
Push the switch to the off position.
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• Menus, functions, and subfunctions are separated from each 
other by the “>” character.

Example:
Select File > Open... 

• Keys you need to press simultaneously are indicated by a “+” 
character preceding the second key.

Example:
Press Alt+A.

Important Text Passages
Important text passages are marked with symbols in the margin, 
which have the following meanings:

Caution: 

Contains information which has to be observed in order to avoid 
damaging the hardware or software.

Note: 

Contains important general or additional information on a spe-
cific topic.

Prerequisite: 

Advises you of any prerequisites which have to be fulfilled to per-
form the subsequent steps.
VI



artem Service
Do you have any questions on our products or do you require spe-
cific information on ComPoint? 

You can contact us, as follows:

• Internet: http://www.artem.de

• E-Mail (Service): contact@artem.de

• E-Mail (Hotline): techsupp@artem.de
VII

http://www.artem.de


The ComPASS Product Package
The following components should be contained in your 
ComPASS product package:

• ComPASS,

• power supply,

• quick start flyer,

• installation CD-ROM,

• flyer with information for the user and declaration of confor-
mity.

Note: 

If your ComPASS product package does not meet your demands, 
please contact our artem Service (see Abschnitt artem Service).

You can find a description of the standard components of the 
ComPASS product package in the Abschnitt Hardware Descrip-
tion, Seite 1–1.

System Requirements
Hardware requirements for the configuration of the ComPASS 
and for the operation of the end device by the user:

• PC with wireless LAN adapter (integrated: PCMCIA card or 
external: e.g. USB). For the configuration, a PC with network 
access can be used, as well.

• Compatible with IEEE 802.11b (11 Mbps @ 2.4 GHz), IEEE 
802.11g (54Mbps @ 2.4 GHz), Wi-Fi

• Microsoft Internet Explorer, version 5 and higher, or Netscape 
Navigator, version 4.7 and higher

• TCP/IP transfer protocol
VIII



Settings at the PC:

• Activate DHCP.

• Activate cookies in the Internet browser.

• Deactivate the settings for the connection for your local net-
work (proxy) in the Internet browser.

• Deactivate WEP encryption for the WLAN adapter.

• Activate JavaScript in the Internet browser.
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Hardware Description
1 
Hardware Description
This section contains photographs and figures of the individual 
components of the ComPASS product package, as well as further 
information on the parts in question.

Which features does the ComPASS have to offer?

With the artem ComPoint Common Public AccesS Server 
(ComPASS) you can set up an access to the Internet (a so-called 
hotspot) while you are staying in a hotel, waiting room, or on the 
company premises. The by now widespread wireless LAN technol-
ogy (IEEE 802.11b, IEEE 802.11g, Wi-Fi) offers you a convenient 
and fast access to the Internet. With the help of prepaid cards, 
users equipped with a laptop, PDA, or another mobile computer 
with wireless LAN technology are able to select and make use of all 
options provided by the Internet.

ComPASS is a very compact server with integrated software for 
the complete management of the hotspot. It provides access to the 
Internet via a built-in DSL router. For this purpose, only a DSL 
access including modem is required. Alternatively, the user can 
access the Internet via an existing LAN and its routers. The wire-
less hotspot is implemented via an access point, such as the artem 
ComPoint. 
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Hardware Description
Setup of the ComPASS

Front View of the ComPASS

• LCD display with status overview
• LEDs to control the WAN and LAN functions and the operational 

state 
Rear View of the ComPASS

• 2 USB ports v 1.1
• 2 Com-Ports (serial)
• 1 Printer port (parallel)
• 4 LAN ports (RJ45)
• 1 WAN port (RJ45)
• Round connector for power supply (18-30 V DC)
• On/off switch
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Hardware Description
Connection Options at the ComPASS

Serial Ports

The USB and Com-Ports are not required for the operation of the 
ComPASS as wireless hotspot. So far, they serve no function.

Parallel Port

The parallel printer port is not required for the operation of the 
ComPASS as wireless hotspot. So far, it serves no function.

LAN (RJ45) Ports

• artem ComPoints for wireless cells
• artem ESCs for wireless cells
• Hubs or switches for the connection of more than 4 devices
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Hardware Description
WAN (RJ45)

• DSL modem
Note: The DSL modem displayed here is just an example; 
you can use any device.

• Router with integrated modem functions, e.g. DSL router
Note: In principle, Internet access data are independent of the 
provider. As a rule, you are given these data when concluding a 
contract. You can find more information how to use the Internet 
access data for the configuration of the ComPASS in Abschnitt 
Setup > Internet Access, Seite 1–5.
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Hardware Description
Principal Setup of a Wireless Hotspot

Variant 1

The artem ComPASS is set into wireless hotspot operation by 
means of one or several artem ComPoints. The connection to the 
Internet is set up directly via DSL modem.

Variant 2

The artem ComPASS is set into wireless hotspot operation by 
means of one or several artem ComPoints. The connection to the 
Internet is set up via a company-owned router.

In this operation mode it is possible to provide a large area with 
Internet access for the customers and at the same time to offer the 
employees access to the company network via VPN. The size of the 
wireless network can be extended almost beyond any limits.
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Hardware Description
Commissioning of the ComPASS

1. Connect the ComPASS via the power supply to the mains 
power supply network.

2. Connect one or several artem ComPoints via the LAN 
ports to the ComPASS. 

3. Connect the ComPASS via the WAN port to the DSL 
modem or to a router with Internet access.

4. Switch on the ComPASS.

The device display reads:

Booting up
Please wait!

5. Wait until the ComPASS display reads:

ComPASS <max user> <version> Public Access 
Manager

The device is now read for operation and can be configured.

1. Plug in 
mains power 

2. Connect to rou-
ter or DSL modem

3. Connect 
ComPoints

4. Switch on device
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Configuration
1 
Configuration
This chapter describes all settings which can be made via the Web 
user interface in detail.

Access to the ComPASS

To configure the ComPASS, you have to access the device via a PC. 
The following access options are provided:

1. Via a mobile PC with artem ComCard and an artem Com-
Point.

2. Via a PC which you connect to the LAN port of the Com-
PASS.

Note: DHCP has to be activated on the computer which you use to 
access the ComPASS.
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Configuration
Starting the Configuration Interface

1. Start your browser.

2. Call  https://www.artem.wlan/adminstation/jsp/
Start.jsp .

Note: For reasons of security, use HTTPS for data exchange.

The Enter Network Password dialog box is displayed.

3. Enter User Name admin.

4. Under Password, enter the factory-set password admin.

The configuration interface of the ComPASS is started now.
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Configuration
Note: 

For reasons of security, you should modify the password immedi-
ately after starting the configuration interface for the first time. 
Refer to Abschnitt Setup > Password, Seite 1–9. The password 
cannot be reset to the factory setting, any longer.
2-3



Configuration
Setup of the Configuration Interface

The configuration interface is set up, as follows: 

• In the left upper corner, you can select the language of the interface. 
You can choose between:
• Deutsch (German) and
• English.

• The menu bar serves to navigate the interface. The following menu 
items are available:
• START
• SETUP
• CARDS
• AVAILABLE CARDS
• ACTIVE CARDS
• ONLINE USERS
• RESET
• LOGO
• LICENCE/UPDATE
• TEXTS
• INFO
• FAQ
• HELP
2-4



Configuration
The Setup Menu Item

Under Setup, you can configure the ComPASS.

Note: 
Confirm all modifications which you make under Setup by click-
ing the Save button. Subsequently, restart the services under Setup 
> System to activate the modifications in the system.

Setup > Internet Access

Under the Setup > Internet Access menu item, you an define how 
the ComPASS will access the Internet.
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Configuration
• LAN: For the operation of the ComPASS within a LAN.
• DHCP: The ComPASS attempts to obtain its IP address, the subnet-

mask, the broadcast address, and the gateway address from a 
DHCP server in the network. 
This function is only available if the ComPASS is connected to a 
central DHCP server via the WAN port.

• Fixed IP address: You can use this option if you wish to assign a 
permanent IP address to the ComPASS.
Under IP address, Network mask, Broadcast address, and 
Standard gateway, enter the selected values. If you have any 
problems, consult your network administrator. 

• DSL: For the access to the Internet via DSL.
If you wish to operate the ComPASS via DSL, enter your 
access data here. You will receive the access data from your 
provider (e.g. T-Online).

• ISDN: 
Note: 
In terms of its hardware, the device has not been equipped for the 
operation via ISDN. Please consult the artem support department if 
you wish to configure the ComPASS for the operation with ISDN. 

The entry of the data for ISDN is made similarly to the con-
figuration for DSL. You have to specify the call number to 
be dialed, however. An additional option is the ISDN phone 
number prefix, which enables you, for instance, to consider 
the extension of a telephone set. Under ISP domain name, 
you can enter the name of your Internet service provider. 
The fields Area code and Phone number can be used for 
your identification and to transfer the phone number dur-
ing the dial-in. Both fields do not have to be filled in if this 
has not been determined as a technical prerequisite by 
your provider.
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Configuration
• 1. DNS Server and 2. DNS Server: 
Here, you can enter the IP address of a DNS service. It is 
possible to enter local or global DNS server addresses. 
DNS services permit the resolution of IP addresses into 
domain names (e.g. www.artem.de).

Note: The 1. DNS server and 2. DNS server fields only have 
to be filled in if you are operating the ComPASS via the LAN 
and with a permanent IP address. 

Setup > Public Access Manager

• Public Access Manager location Id: Each artem ComPASS possesses 
an unambiguous location identifier, which is displayed in this field.

• Hotspot Name: Here, you can assign a name to the device. If several 
ComPASS units are configured, this makes it easier to distinguish the 
devices quickly and conveniently.

• Hotspot Homepage: This address is the default address first dis-
played to the user when accessing the Internet via the hotspot. It can 
be compared to the start page of the Internet Explorer or Netscape 
Navigator. It will be automatically used as primary entry to the 
Walled Garden websites. Here, you can specify your proper website, 
for instance.

• Hotspot Menu Item: Display of the hotspot name within the config-
uration interface. For instance, in the title bar to the right of the lan-
guage selection.
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Configuration
Setup > Walled Garden

The Walled Garden function of the artem ComPASS allows to 
specify up to 8 Internet addresses which you can access gratu-
itously via the hotspot. 

Enter the selected free Internet addresses.

Setup > WLAN

Here, you can enter and modify all settings which concern the 
wireless infrastructure.
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Configuration
• WLAN Base Address: The basic address section out of which the IP 
addresses of the logged-on clients are distributed.

• WLAN Host Address, WLAN Address Range, WLAN Broadcast 
Address: Displays the mentioned parameters independent of the 
WLAN base address.

• DHCP Start and DHCP End: Specify the IP section which the Com-
PASS is to assign to the access points.

• DHCP Default Lease Time: Preset validity period of an IP address, 
which is assigned in the ComPASS via the DHCP service to a client. 
The value 7200 seconds corresponds to 2 hours.

• DHCP Maximum Lease Time: Maximum validity period of an IP 
address, which is assigned in the ComPASS via the DHCP service to a 
client. The value 14400 seconds corresponds to 4 hours.

• Portal Protocol: Type of connection of the clients to the ComPASS.
• http (Hyper Text Transfer Protocol) corresponds to the normal con-

nection.
• https (Hyper Text Transfer Protocol Secure) corresponds to a very 

secure connection.
Note: For reasons of security, you should activate https.

Setup > Password

Here, you can modify the user name and the password required to 
access the configuration interface.

Note:
The factors setting is “admin” both as user and password. For rea-
sons of security, you should modify the password immediately 
after starting the configuration interface for the first time. The 
device will only work after performing this step. The password 
cannot be reset to the factory setting, any longer.

Confirm your entries or modifications by clicking the Save but-
ton.
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Configuration
On the following page, click the Restart Services button to acti-
vate the modifications in the system.

Setup > Central

If you are using a central authentication service to log on users at 
the hotspot, you can make the corresponding settings here. You 
will receive the data from the operator of the central authentica-
tion service.

• Central server: Name or IP address of the central authentication 
server.

• Server password: Password of the corresponding server for log-on 
via the ComPASS.

• Central backup server: Name or IP address of the central backup 
authentication server.

• Backup server password: Password of the corresponding backup 
server for log-on via the ComPASS.

• SSL certificate: Option to upload an SSL certificate for secure SSL 
authentication at the server.
2-10



Configuration
Setup > Remote Administration

Note:
Remote administration only has to be configured if you are oper-
ating the ComPASS via DSL and wish to administrate the device 
from remote. Remote administration does not have to be config-
ured if you are operating the ComPASS in the LAN. In this case, 
you can access the device via the name or IP address, as usual. 

For further information on remote administration via DSL, please 
refer to Abschnitt Configuration of the Remote Administration 
for DSL, Seite 1–1. You should also consult the artem support 
department if you wish to configure remote administration for 
DSL. 

Setup > System
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Configuration
• Restart Services
Activates all modifications in your system. This process 
may take some minutes. 

• View Protocol
Enables you to view a detailed listing of the modifications.

• Shutdown
Exits all running services. This process may take some min-
utes.

You should only switch off the ComPASS after exiting all 
services.

• Set Date and Time
This option enables you to set a date and time for the sys-
tem. Enter a date and time and click the Set Date and Time 
button.

Date and time have to be specified to output of the point of 
time of the first log-on of a user. Also refer to Abschnitt The 
Active Cards Menu Item, Seite 1–16.
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Configuration
The Generate New Prepaid Cards Menu Item

Here, you can generate prepaid cards for users.

1. Specify how many prepaid cards you wish to generate.

2. Click the Generate button.

You will get to the Download new Prepaid Cards Data page.

3. Click Download to download the data of your new prepaid 
cards.

4. Specify where you wish to store the file with the card data.

5. Check the corresponding box and click the Confirm button 
to confirm that you have successfully stored the prepaid 
card data.

The new prepaid cards will now be displayed under Available 
Cards.
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Configuration
You can open the saved file with the card data under an editor or, 
for instance, under Microsoft Excel, administrate them and print 
the card data on the shipped or proper flyers and distribute them 
among your users. 

Example for a flyer with printed card data:

Data of the pre-
paid card
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Configuration
The Available Cards Menu Item

Here, you can administrate your prepaid cards.

• To delete an individual card from your card pool (e.g. after loss of this 
card), enter the corresponding card number and click the Delete but-
ton next to the entry field.

• To be able to survey the list of available cards conveniently, you 
should delete the inactive (i.e. invalid) cards from time to time. To do 
this, click the Delete button.

• The first table provides a complete view of all available cards.
• Type of Tariff: Currently, only the PrePaid Time option is available 

here.
• Credit: Number of the valid days / hours of the cards. After gener-

ating, prepaid cards will be valid for 24 hours. After the first log-
on by a user, this time interval starts to run out.

• Total Number of generated cards.
• Available Cards: All cards still available, i.e. all cards on which a 

time credit is still registered. 
• The second table contains the data of all available prepaid cards. In 

addition, it contains the following table fields:
• Card Id: Serves to identify the card unambiguously.
• Available: Specifies whether the corresponding card is available or 

not.
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Configuration
The Active Cards Menu Item

Active prepaid cards comprise all cards used by a user to log on for 
at least one time. 

• To delete an active card from your card pool, enter the card number 
and click the Delete button.

• This fields of the table contain the following information:
• Card Id: Serves to identify the card unambiguously.
• Type of Tariff: Currently, only the PrePaid Time option is available 

here.
• Initial Login: The date and time of the first log-on performed on 

the card.
• Remaining Time: The remaining validity period of the card, speci-

fied in hours and minutes.
• Currently Online: Specifies whether the card displayed or the user 

is currently using the access.
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Configuration
The Online Users Menu Item

All users who are currently accessing the Internet and are using 
the hotspot access are listed here in the form of a table. The follow-
ing data are displayed:

• Card Id: Serves to identify the card unambiguously.
• Type of Tariff: Currently, only the PrePaid Time option is available 

here.
• First Login: The date and time of the first log-on performed on the 

card.
• Remaining Time: The remaining validity period of the card, specified 

in hours and minutes.
• IP Address: IP address of the computer which is currently using the 

hotspot access.
• MAC Address: MAC address of the computer which is currently using 

the hotspot access.
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Configuration
The Reset Menu Item

The user has the option to modify his PIN for the hotspot on the 
welcome page and to assign a password to himself. If he forgets his 
password, the password can be reset here to the initial card PIN.

To do this, enter the card number and click the Reset button.
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Configuration
The Logo Menu Item

Here, you have the option to adapt the design of the Public Access 
Manager to your wishes.

To do this, you can import a start graphic and an operator logo. 

Please delimit your choice of graphic formats to JPG, GIF, PNG, 
or BMP files. 

1. Use the Browse... button to select a graphic file for the 
start page or an operator logo.

Note: For the dimensioning of the start graphic, always 
enter the smallest possible monitor size and the related 
maximum resolution. An ideal value is, for instance: 640 x 
480 pixels.

Note: The size of the operator logo should not exceed 150 
x 40 pixels.

2. Click the Read in button. 
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Configuration
The start graphic and the operator logo will be displayed on the 
log-on page for the user:

Operator logo

Start graphic
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Configuration
The Licence/Update Menu Item

Licence

By reading in a new licence file you can increase the number of 
users accessing the hotspot simultaneously from 20 to 250. You 
can directly purchase this licence file from artem.

1. Select the new licence file via the Browse button.

2. Click the Read in button.

3. Restart the ComPASS services (Abschnitt Setup > System, 
Seite 1–11).

The new licence file has been installed.

Update

By updating the firmware you will keep the functional scope of 
your ComPASS up-to-date. If want to find out whether an update 
is available, go to http://www.artem.de. To install a firmware 
update, proceed as follows:

1. Download the new firmware package.

2. Decompress the ZIP file.

After decompressing the file, you will find a second ZIP file and a 
Readme.txt file. The Readme file contains information on the 
update.

3. Select the second ZIP file (update_PAMxxx_toPAM-
xxx.zip) via the Browse button.
2-21
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Configuration
4. Click the Read in button.

5. Restart the ComPASS services (Abschnitt Setup > System, 
Seite 1–11).

Note: If the Error 500 message is displayed, switch the 
ComPASS off and on again.

The update has been installed.

The Texts Menu Item

You can provide general terms and conditions, as well as more 
information for the user on the start page of the hotspot.

1. Create your general terms and conditions or other infor-
mation and save the data as text file (ending .txt).

2. Select the language of the text.

3. Select the text file and click the Browse... button.    
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Configuration
4. Select the default language in which the general terms and 
conditions will be displayed. The general terms and condi-
tions will then be displayed in this language if no terms and 
conditions have been read in for a language.

5. Click the Read in button.

The general terms and conditions or the text with information has 
been imported and will be provided for the user on the start page 
Info.

Under Info, you can also select the default language on the start 
page for the user.

1. Under Default language of the start page, select the lan-
guage in question.

2. Click the Set Default button.
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Configuration
The Info Menu Item

On the Info page, you can view general settings and device options 
at one glance. The Info category comprises the following points:

• Version of the Public Access Manager (device version)
• The Location Id: Device number
• The version of the internal service pack of the device
• Standard Billing: Tariff type, i.e. the type of time billing
• Option Pack: Display of the available additional features of the Com-

PASS, i.e. radius authentication. Corresponding updates can be 
directly purchased from the manufacturer.

• Base Language: The preset default language of the configuration 
interface

• Language Option: Languages selectable for the configuration inter-
face

• Public Access Manager licence: Type of licence
• maximum number of parallel users: Number of possible parallel 

access procedures via the artem ComPASS (20 or 250)
• Central Service Gateways: Display of the central authentication 

server, if available.
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• Language Option: Language settings selectable for the configuration 
interface.

The FAQ Menu Item

Under this menu item, you can find the answers to frequently 
asked questions.

The Help Menu Item

Calls the First Steps brochure.
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1 
The Hotspot from the Viewpoint of the User
Users can use the hotspot with the help of a prepaid card. For 
information how to generate prepaid cards, refer to Abschnitt The 
Generate New Prepaid Cards Menu Item, Seite 1–13.

Log-On to the Hotspot

If the user starts his browser in the range of your hotspot for the 
first time and if he attempts to set up a connection to the Internet, 
he will get to the log-on page of your hotspot. There, the Internet 
addresses are specified which can be visited gratuitously without 
prepaid cards. For information how to configure this gratuitous 
section, refer to Abschnitt Setup > Walled Garden, Seite 1–8.

Gratuitous 
section
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To visit further sites, the user has to log on with the help of the 
Card Id and PIN of his prepaid card and has to click the Login but-
ton. The user then gets to the welcome page of your hotspot, 
which contains general information and information on his cur-
rent time credit. 

You can design the log-on and welcome page with your own logo 
and graphics. Refer to Abschnitt The Logo Menu Item, 
Seite 1–19.

Language Selection

In the upper left corner on the welcome and log-on page, the user 
can set his preferred language for the hotspot user interface. You 
can preset the default language. Refer to Abschnitt The Texts 
Menu Item, Seite 1–22.
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The Home Menu Item

Leads the user back to the welcome page.

The Change Password Menu Item

Under Change password, the user can change his PIN into a 
freely selected password.

If the user forgets his password, you can reset it to the initial PIN. 
Refer to Abschnitt The Reset Menu Item, Seite 1–18.

The Info Menu Item

Under Info, the user can find general information on the access to 
the hotspot and your general terms and conditions. You can create 
and design your own info text and general terms and conditions. 
Refer to Abschnitt The Texts Menu Item, Seite 1–22.

The Hotspot Provider Menu Item

Here, you can insert a link to your proper website, for instance. 
The user can visit this page gratuitously. For information how to 
insert a link to your website, refer to Abschnitt Setup > Public 
Access Manager, Seite 1–7.
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Configuration of the Remote Administration for DSL
1 
Configuration of the Remote Administration for DSL
Caution:

The configuration of remote administration for DSL should only 
be performed by experienced users. If you have any questions, 
consult the artem support department.

To perform remote administration for the ComPASS via DSL, you 
first have to register the ComPASS at the DynDNS provider as 
host. 

Registering the ComPASS at a DynDNS-Provider

The process is explained with the example of DynDNS.org:

1. In the browser, call https://www.dyndns.org .

2. If you do not yet have an account at DynDNS: Set up a new 
account as described on this site.

3. Register the ComPASS under Dynamic DNS as new host.

Specify the name of the ComPASS as host name and select 
a domain. Follow the instructions given by the provider. 
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4. Click the Add Host button.

The ComPASS has been registered as host at the DynDNS pro-
vider. 

Note: 
Depending on the selected DynDNS provider, it may take some 
minutes until the name of the ComPASS will be resolved correctly.
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Configuration of Remote Administration

In the configuration interface of the ComPASS under Setup > 
Remote Administration, you should now make the settings 
required to prepare the ComPASS for remote administration.

• DynDNS Server
Enter the name and IP address of the server which provides 
the dynamic DNS service. You will receive this information 
from the DNS provider.

• Dynamic domain name
Specify the name of the ComPASS which you have regis-
tered at the dynamic DNS service.

• DynDNS username and DynDNS password
Enter the user name and the password which you use to log 
on to the dynamic DNS service.

• SSH port number
Here, you can modify the SSH port number. Port 22 is used 
by default.

• Create a new certificate
4-3



Configuration of the Remote Administration for DSL
Caution:
Here, you can create and download a certificate which you 
can then use to access the ComPASS via remote adminis-
tration as root over a secure connection. On this system 
level, the device should be accessed by very experienced 
users only. For further information, refer to Abschnitt 
Remote Administration via DSL as Root, Seite 1–5.

Note:
As soon as you have created a certificate, the normal regis-
tration as root with user name and password via SSH will 
be deactivated. You then have to use the certificate to log 
on for remote administration. 

To create a certificate, select the Yes option under Create a 
new certificate. Restart the services under Setup > System.

• Download last created certificate
1. To download the certificate created last by the ComPASS, 

click the Download button. 

The certificate will be displayed.

2. Save the certificate as text file.

To be able to use the certificate, you have to use the SSH 
client. Refer to Abschnitt Remote Administration via DSL as 
Root, Seite 1–5.

• Delete all previously created certificates
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Deletes all previously created certificates. 

Remote Administration via DSL Using the Configuration Interface

1. Start your browser.

2. Call the URL which you have registered as host name at the 
DNS service provider (e.g. https://compass-1.dyndns.org/
adminstation/jsp/Start.jsp).

Hinweis: 
For reasons of security, use https for data transfer.

3. Log on with the help of your user name and password. 

You will get to the ComPASS configuration interface and will be 
able to perform remote administration.

Remote Administration via DSL as Root

Caution:
Only very experienced users should access the ComPASS as root. 

To perform remote administration as root, you require a certifi-
cate. For information how to create and download certificates, 
refer to Abschnitt Configuration of Remote Administration, 
Seite 1–3.

You have to process this certificate and to read it in into your SSH 
client to be able to register as root via remote administration at the 
ComPASS. The procedure is described in the following with the 
example of the SSH client PuTTY. You can also use another client.
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1. Open the certificate under an editor.

2. Insert a return into the first line after KEY----, delete the 
space at the beginning of the first line, and insert a return 
before ---END. 
The certificate should have the following or similar form:

3. To create a valid certificate from this text file, open the 
PuTTY key generator (PuTTYGen).

4. Under Parameters – Type of key to generate, select the 
SSH2RSA option.

5. Click the Load button and select a text file.
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6. Click the Save Private Key button and confirm the subse-
quent message with Yes.

The certificate will be created. You can now use the certificate to 
access the ComPASS as root.

1. Start the putty.exe.

2. Under Session, enter the host name of the ComPASS and 
select the SSH option under Protocol.

3. Under SSH > Prefered SSH protocol version, select option  
2.
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4. Under Auth, make the following settings and select the cre-
ated certificate via the Browse button.

5. Click the Open button.

You can now log on as root and perform remote administration.
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1 
Messages on the ComPASS Display
There are five different categories of display messages, which are 
shown in fixed intervals and in sequence on the display:

• System Messages, e.g. outputs during the setup process
• Product Information, such as product name, version and licence 

information
• User and card statistics, such as the display of active users and avail-

able user accounts
• Status of the Internet Connection
• Status of the Connection to a Central Server
Note: The “<...>” characters mark variables which are filled with 
values depending on your configuration.
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System Messages

Line Display Message Meaning

1 Trying to ping Internet access test

2 www.artem.de

1 still trying to 
ping

Internet access test

2 www.artem.de

1 Internet access: Error message upon failed Internet access test

2 Err: 2

1 Internet access 
err.

Error message upon failed Internet access test

DNS resolution OK, but ping failed

2 for www.davonet.de

1 Internet access OK! Internet access was tested successfully

2

1 Restarting... Restart of services

2

1 Restarting network. Restart of network services

2

1 Testing free sites. Access test on free sections of the Walled Garden

2 <walled_site[i]> 

1 Error accessing Access test for walled site failed

2 <walled_site[i]>

1 Error accessing Access test for central server failed

2 <center>
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Product Information

User and card statistics

1 Starting services. Restart of the systems services

2

1 Reboot in progress Reboot

2 Please wait ...

1 Reboot in progress Shutdown

2 Please wait 1 
Minute

1 Access Control Deactivation of the access control during the reboot of 
the services

2 disabled

Line Display Message Meaning

Line Display Message Meaning

1 ComPASS - <max_users>  
<version>

Product name, maximum number of parallel 
users, version number

2 PublicAccessManager

Line Display Message Meaning

1 Active Users: <n> Number of registered users

2 Local Cards: <m> Number of available card which have not been 
registered so far. Cards with remainder time cre-
dits are not considered.
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Status of the Internet Connection

Note: 
In terms of its hardware, the device has not been equipped for the 
operation via ISDN. Please consult the artem support department 
if you wish to configure the ComPASS for the operation with 
ISDN. 

Line Display Message Meaning

1 ISDN connection: up Display of details on the ISDN connection

Public IP address2 IP: <inet-ip>

1 ISDN connection: down ISDN connection offline

2

DSL connection: up Display of details on the DSL connection

Public IP addressIP: <inet-ip>

1 DSL connection: down DSL connection offline

2

1 DSL connection: down DSL connection offline

Error during the initialization of the DSL driver2 device is down

1 LAN connection: up Display of details on the LAN connection

IP address in the LAN2 <inet-ip>

1 LAN connection: down LAN connection – cable disconnected

2

1 Unknown connection: 
down

Type of Internet access not configured

2
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Status of the Connection to a Central Server

Line Display Message Meaning

1 Center Station: Display of the status of the connection to the cen-
tral server for the central authentication service.

Hostname is either the domain name or the IP 
address of the central server, corresponding to 
the entry under Setup > Central.

2 <hostname>

1 Center Station: Display of the status of the connection to the cen-
tral server. Server is not available.

2 not connected
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